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our iMac is right there

in front of you in its

sealed box. It’s the

moment of truth but

it’s not the three-dimensional

jigsaw puzzle you might be

dreading, and the box contains

just the following six items:

• The iMac itself

• Keyboard

• Mouse

• Mains and modem leads

• CDs

• Documentation

If your iMac arrived in a

factory-sealed box and you

haven’t found one of the above

items, it’s because you’re not

looking in the right place! 

If you’re buying a used iMac

or an ex-demo model from a

store, make sure they are all

present and correct before

leaving the place of purchase.

While much of the software on

the CDs is pre-installed anyway,

you may need the Restore and

Install CDs for sorting out

possible problems in the future.

The CDs also contain bonus

software that’s not pre-installed

on the hard disk.

What if it doesn’t work?

It’s rare, but it might happen. If

a fault develops some time after

you bought the machine, the

dealer can rightly insist that

you take the matter up with

Apple directly under the terms

of your one-year warranty. But if

the machine or one of its

components is faulty straight

out of the box, you’re entitled

to reject it under the Sale of

Goods Act and claim a

replacement or

a refund.

The onus is

on the dealer to

take

care of it.

Where do you
put it?

Obviously, you’ll

need to be within

reach of a mains

socket, but if you

plan on using email

and the Internet,

you’ll need to 

choose a spot close

to a phone socket too. You

can get telephone extension

leads from any DIY or electrical

store, though. 

Make sure your iMac isn’t

facing a window directly, since

the bright light reflecting back

off the screen will make the

display difficult to read. Don’t

position your iMac with its back

to a bright window, either, since

your eyes will find it difficult to

accommodate the difference in

brightness between the screen

and the scene outside.

And, although the iMac’s

desktop ‘footprint’ is quite

small compared to other

computers, you’ll need a foot or 

more of space in front of it for

your keyboard, plus a few

inches to the left or right for

using the mouse. Many narrow

‘computer desks’ are unsuitable

for any modern computer

because they don’t leave room

for the mouse.

Rip off the tape and throw open the box.
It’s just like Christmas, isn’t it?

Getting started

Modem
The gadget that converts the
digital data used by your iMac
into signals that can be sent
along normal phone lines. The
iMac has a modem built in, but
you’ll still need to connect it to
the phone socket in the wall
using the cable supplied.

Pre-installed
iMacs come with a variety of
software already on the hard disk.
This includes the system
software, which the iMac needs in
order to start up and run, and
various applications (programs)
like AppleWorks.

RSI
RSI stands for ‘repetitive strain
injury’ and describes a painful
condition suffered by many
typists. It’s often the result of
bad keyboard postioning and
awkward wrist angles.

Restore CD
This is a CD supplied with your
iMac at point of purchase which
will restore the pre-installed
software in the event that it’s
accidentally deleted, corrupted
or otherwise meddled with.

Install CD
Normally, your iMac will start up
using the system software on the
hard disk. If this fails for any
reason, you can start
up from 
this CD, which
itself contains 
a (cut-down)
copy of the 
system software.

Jargon
buster

Y

02 youriMac

Top tips

You’ll have spotted already that you can plug

the iMac’s mouse into either end of the keyboard.

So you plug it into the righthand end for right-

handed use and the lefthand end if you’re left-handed,

yes? By all means... but if you find the loop of cable

connecting the mouse with the keyboard just keeps

getting in the way, you can connect it at the opposite

end and run the cable along behind the keyboard.

When you first put it on your desk, the iMac

screen is parallel with your chest rather than your line

of sight, but you can tilt the monitor backwards and

swing it forward with the hinged bar on the underside.

This acts as a ‘foot’ for the iMac, tilting the whole unit

backwards a few degrees for a much more comfortable

viewing angle.

You can do a similar trick with the keyboard.

Underneath there’s a similar swinging bar which you

bring forward to tilt the back of the keyboard upwards.

Easy, huh? If you just take a few minutes over

choosing a location for your iMac and setting it up

properly, you’ll find it much easier and more

comfortable to use for long periods.
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What’s in the box?
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kay, it’s time to plug

in the iMac and

switch it on. But

what goes where?

Everything revolves around the

twin USB ports on the

righthand side of the machine,

towards the back. USB is the

newest standard for connecting

computers and peripherals, like

scanners, printers and, in the

case of the iMac, keyboards and

mice. There are two USB

sockets in the iMac casing, but

you’ll only need one of them,

for plugging in the keyboard.

If you’re not going to use

the other socket, where does

the mouse go? It too uses a USB

connection, but if you take a

look at the iMac keyboard you’ll

see it has two USB sockets of its

own, one at either end. The

keyboard is, in fact, a USB ‘hub’.

With the mouse connected

to the keyboard and the

keyboard connected to the

iMac, all you have to do is put

the mains lead into the back of

the iMac, plug it into a wall

socket and you’re ready to go.

Starting up

To start your iMac, you can

press one of two Power buttons:

on the front of the iMac or the

one on the keyboard.

The iMac will ‘chime’ as it

starts up, and first you’ll see a

happy Mac face, then a

Welcome screen and finally a

row of icons will appear along

the bottom of the screen as the

system software loads. You’ll

know your iMac has finished

starting up when you see the

desktop and its icons and the

menubar along the top of the

screen. You’ll probably

hear that the audible hard

disk activity during

startup has ceased.

Startup takes about 30

seconds, and what’s

happening is that the

iMac is doing a basic

hardware check to ensure

that all the components

are working as they should.

Next, it’s loading the system

software on the hard disk. Only

when this has finished loading

is your iMac ready for use.

Now it’s time to stop admiring the iMac’s good looks and get
down and get your hands dirty…

O

Plug it in, turn it on
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Which OS do you have?

Depending on when you bought

your iMac, it may come with

operating system version 8.5 or

OS 9. There’s a new one coming

out soon too. Apple is always

developing the operating system

to include new features, improve

performance and reliability and

make it easier and friendlier to

use. iMacs are currently shipped

with OS 9 (you can upgrade if

you have an earlier version, but

it’s by no means essential), but

version 10 is in the pipeline and

promises to be a major redesign.

You can easily find out which
version of the operating
system your iMac has by
choosing About This Computer
from the Apple menu

Setup Assistant

If this is the first time you’ve run your iMac, it’ll display the Setup

Assistant, which is a series of screens asking for simple user

information. Typing this information in now will configure your

iMac with details and local information (UK keyboard settings,

for example) as well as the current date and time. You can

cancel the Setup Assistant and come back to it later. You can

even enter the

various settings

manually, using

the Control

Panels, at your

own leisure.

You’ll see the Setup Assistant when starting
your iMac for the first time

You can find out
which version of the

operating system your
iMac has by choosing

About This Computer from
the Apple menu
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Assistant
A step-by-step guide to carrying
out what might otherwise prove
complex or confusing procedures.
Generally, you have to answer
questions or choose from a
simple list of options via a short
sequence of screens.

OS (operating system)
The OS (operating system) is the
‘interface’ between you and the
iMac hardware and the programs
you install on it. It lets you and
your software ‘talk’ to and control
the iMac hardware.

Peripherals
The term used to describe plug-in
computer gadgets or accessories,
for example, cameras, scanners,
printers and disk drives.

Startup
All computers, including both PCs
and iMacs, go through a startup
sequence which includes basic
hardware checks and then the
loading on the system software.
This process can be called
bootup too.

USB
USB stands for universal serial
bus and it is the simplest type of
connection for peripherals. You
don’t have to switch the iMac off

to connect them, and it is
becoming a universal

standard amongst
companies.
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f you’ve never used a

mouse before, you’ll find it

takes a little getting used

to. If you have, you’ll find

it hard to imagine controlling a

computer without one.

At first, it seems almost

magical. You move this small,

pebble-like object on your

desktop and a pointer moves on

the screen as you do it. Before

long, it becomes second nature.

You can perform a wide variety

of operations using its single

button. These operations

include clicking, double-

clicking and dragging.

Clicking

Clicking is used for selecting

objects and opening menus. For

example, you can click on the

Macintosh HD icon

on the Desktop,

then click on the

File menu and then

the Get Info

option to find out

various things

about it (size, free

space and so on). 

If you’re using

a drawing program

or Web page

creation software,

you’d click on an

object to select it so

that you could

change its

appearance or

properties.

Double clicking

Double clicking, by contrast,

makes things happen. If you

double click on the Macintosh

HD icon on the Desktop, it

opens a window showing the

contents of your hard disk. If

you double click on an

application icon, it starts that

application. If you double click

on a document, it opens that

document. Simple eh?

Dragging

Dragging moves things around

or changes their size. You drag

an object by positioning the

pointer over it, pressing the

mouse button and then moving

the mouse without releasing

the button. For example, you

can move a document from one

folder to another by dragging it.

And you can also change the

size of a folder window by

dragging on the box in the

bottom righthand corner. 

You can move windows

around by dragging on their

title bars. (You’ll find out 

much more about windows,

menus, icons and folders over

the next few pages.) Why not

have a quick practice now?

Mouse species

Until the arrival of the new

iMacs this year, the iMac mouse

has always been circular. It

looks and feels nice, but has a

drawback: you can’t feel which

way is forward, and this makes it

more difficult to control the

pointer accurately. This mouse

was modified to include a small

indentation right at the front of

the button, which made a big

difference, but if you own one

of the older mice you can

achieve a similar effect using a

small piece of tape or a label,

positioning it just where your

fingers naturally fall, right at

the front of the mouse button.

Not a furry rodent, this mouse will
quickly become your best friend

Getting started

Cursor
The on-screen pointer you use to
select objects and open menus.
Its appearance may change
according to the software you’re
using and what you’re doing at
the time. In a paint program, for
example, it might turn into a
brush symbol.

Text insertion point
A potential source of confusion
when you’re just starting out. You
use the mouse to click at the
point in your document where
you want to start typing. The
insertion point stays where it is,
even though the mouse pointer
carries on moving around the
screen. Any text you type will
appear at the insertion point,
rather than the current mouse
pointer position. In this
screenshot you can see that we
have put the text insertion point
in at the end of the line. The
cursor will still move around the
screen as normal but text will be
inserted at that point.

Drag and drop
You ‘drag and drop’ files from one
folder to another, for example, or
‘drag and drop’ objects (pictures,
say) from one document to
another. You ‘drag’ the object
(holding the mouse button
down), and ‘drop’ it (or let go)
when it’s in the right position.

Optical mouse
A mouse which uses a light
sensor to detect movement
rather than a rubber ball and
switches. Theoretically more
accurate and precise, an
optical mouse also has
no moving parts to
clog up with dust
and gunk. The
older-style pebble
mouse which
originally came
with an iMac is not
optical. You can tell
because it has a ball.
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The mouse

The pebble mouse

The vast majority of Your iMac

readers will have a

pebble mouse that

looks like this. It

was either

loved or

hated, but it

is generally

accepted

that the

new optical

model is an

improvement.

Double click on applications to
start them, on documents to open
them and on folder or disk icons
to display the contents

Move the mouse pointer over an
object and click once to select it.
Here we’ve clicked on our hard
disk to check its properties (Get
Info, File menu)



he Desktop is  your

working area, where

you lay out and

organise the things

you’re working on. It contains

icons for your hard disk, the

Trash and other items as we’ve

seen, but you can also often see

the desktop ‘behind’ any open

windows and, indeed, you can

return to it by clicking on any

part of it you can see. And

here’s a tipe for you: if you click

on the desktop, then choose

Hide Others, your desktop is

magically cleared.

Returning to the Desktop

can help you stay orientated,

especially if you’re running

several applications at once. It’s

a great place to store files or

folders. Don’t use it as a

dumping ground though, or

your iMac will become a mess!

You may have heard the term before but don’t know quite what it
means. Here we explain the ins and outs of the Desktop

T

The Desktop
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Finder
This is the part of the operating
system you see. It’s the program
you use to organise your files and
folders and to start other
programs. The Finder is always
running in the background as an
integral part of the operating
system software.

Icon
The iMac provides a ‘graphical’
interface. Folders and files are
depicted as visible objects, or
‘icons’. You can drag icons around
in order to move them from one
place to another.

Application
Another word for a software
program. Every file or document
on your iMac has a corresponding
application which is used to open
and edit it. Think of files as the
things you create, and
applications as the things you
create them with.

Volume
Another word for ‘disk’. The
iMac’s built-in hard disk drive is 
a ‘volume’, and so is a CD-ROM
you insert. If you plug in other
types of drive like floppy and Zip
drives, the disks you insert are
‘volumes’ too.

Window
You do all your work in ‘windows’.
These are like real windows, and
they let you see into folders and
disk drives. When you open, for
instance, a word processor
document or a digital photo, it
opens in a window. 

Menu bar
Menus are used by just about all iMac
applications, and they’re accessed by a
menu bar like this, running along the
top of the screen. The menu bar
contains a row of menu headings, 
and you click on a menu heading to
open its menu

Hard disk
Everything on your iMac is stored on
your iMac’s built-in hard disk, even the
items on the Desktop. You can double-
click it to open a window displaying the
contents (you’ll find out more about
windows, icons and folders over the
next few pages)

CD-ROM
You’ll only see
this icon if
you’ve put a
disc in your
iMac’s CD-ROM
drive. Double-
click on the CD
to show
contents. When
you drag the
CD-ROM icon
into the trash,
the disc is
ejected and the
icon disappears

Printer icon
You may see
other items on
your desktop.
This, for
instance, is a
printer icon,
and you can
sometimes
drag your
documents to
this icon to
print them
instead of
opening the
documents
themselves
and printing
from within the
relevant
application

Alias
An Alias is like a shortcut to an
item stored somewhere else.
Indeed, if you’ve used PCs
running Windows 95 or 98 you’ll
be familiar with ‘shortcuts’
already. This is the iMac
equivalent 

Trash
The place where you throw items you
no longer need. It doesn’t get emptied
immediately, though. Indeed, you have
to manually empty the Trash. It’s rather
like a wastepaper basket or dustbin:
handy for people who throw things
away and then regret it later

Folder window
This is the window which appears when we
double-click on our iMac’s hard disk icon. It
displays a list of the files and folders stored
on our hard disk. Practically everything you
see and do on your iMac happens in windows
of one form or another

Desktop background
Choose from many
different background
colours, textures and
even images. Open the
Apple menu, choose
Control Panels and then
the Appearance option on
the submenu which pops
up. Click the Desktop tab,
and you’ll see a list of
patterns. Click Place
Picture. You can even
select any image on your
hard disk to use as a
background

AppleWorks
is just one of
the products
you get with
your iMac.
It’s a
collection of
applications
in one
package
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et used to windows

because you’ll be

using them

frequently with your

iMac. As with real windows, they

allow you to see what’s going on

inside. You can see all files in

each folder.

An integral part of iMac life, using your
windows will soon become second nature

Getting started

Dialog
Dialogs are widely used in iMac
applications. They’re windows
which list a series of options and
controls for deciding on
everything from the formatting of
the text in a word processing
program to the size of your
digital photographs.

Palette
A palette is a kind of cross
between a window and a dialog. It
offers the kind of options and
controls you get in a dialog, but
stays open and floating on the
screen all the time so that it’s
constantly accessible.

Pop-up menu
Dialogs and some application
windows offer menus of their
own, quite separate from the
main menu bar. They’re usually
indicated by a downward-facing
arrow, click on the arrow, and the
menu pops up (or down, to be
more accurate). Below is an
example of a pop-up menu on
your desktop. Set this up via the
View menu. You’ll see an As
Popup Window option.

Button
Dialogs usually contain at least
two buttons – OK and Cancel.
You click the OK button to apply
the settings you’ve chosen and
the Cancel button if you change
your mind. Many applications
rely heavily on buttons.

Toolbar
As well as menus and dialogs,
many applications use toolbars
to speed up common operations.
Like the menu bar, toolbars run
across the top of the screen.
They contain rows of buttons
which you click on once to 
carry out specific actions (as
opposed to choosing actions
from a menu).
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Close box
Click this box to close the 
window if it’s a folder window or
close the document if it’s a
document window

Active window
You click on a window to make it
‘active’. The window behind this
one is ‘inactive’, and we can’t do
anything with it until we click on it

Title bar
A window’s title bar shows the
name of the folder (if it’s a folder
window) or a document (if it’s a
document window. You can drag
anywhere on this ribbed bar to
move the window around 

Collapse box
Click on this to collapse the
window to its title bar – useful
for getting the window out of
the way to access windows or
items underneath it. Click again
to expand the window

Scrollbar
If the window’s not large enough
to show all contents, the
scrollbar becomes active. Hold
the pointer down on the up/
down/left/right arrows to scroll
around, or drag on scroll boxes

Size box
Drag on this to resize the
window

Document window
When you open a file using
an application, it appears in a
window like this. They can
be moved and resized

Finder window
This is what you see if you
double click on your hard
disk icon, or on a folder icon.
It displays the contents of
the disk or folder, which may
be files/documents or
further folders 

et to grips with

menus and you

won’t go far wrong.

They show you

what’s going on in each

application and you can find

every function in the menus.

Menus are lists of options which come
from the bar at the top of the screen

G

Menus

Zoom box
Clicking this enlarges
the window as far as
the screen permits to
show the contents of
the folder or document.
Click again to revert to
your previous view

Windows

Menu bar
Every application, including the
Finder (the part of the iMac’s
operating system that you see
and work with) has a menu bar.
You click on one of the menu
titles to open that menu

Submenu
Where you see a right-facing
arrow next to a menu option,
this means that option opens
out into a further ‘sub’ menu
when you move the mouse
pointer over it

Keyboard shortcut
Some menu options are so
useful and they are needed
so often that program makers
have included keyboard
shortcuts. Press the keys
indicated as above 

Menu
A list of options, grouped according to
general function. The File menu handles
functions relating to opening, closing and
saving files. Move the mouse pointer down
the list and click the option you want

Disabled item
When a menu item is ‘greyed out’, it
means it’s unavailable because it applies
to an option or function not available at
that particular time

Ellipses
When you see a row of three dots
(ellipses) after a menu option, it means
that choosing that option will open a
dialog box where you need to make
further choices



t may well be small and

quite easy to overlook but

it’s also very important.

Don’t miss the apple

symbol in the top lefthand

corner of your screen. Here we

tell you how it will be useful to

you in the coming weeks.

The Apple menu is your access to many functions
and controls in your iMac

I
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Apple Menu Items
This is the name of the folder in
the System Folder that contains
all the items you see on the Apple
menu. Unlike other menus, you
can put whatever you like on the
Apple Menu, making it a rapid
route to all your most frequent
daily activities.

Defaults
Defaults are preset choices in
dialogs and menus. For example,
your printer will be set to a
‘default’ paper size which you’ll
have to override if you want to
use a different size.

Extensions Manager
Control Panels and System
Extensions are individual
components that are loaded
along with the operating system
when you start up. Sometimes
you may need to disable one or
more of these components, and
the Extensions Manager Control
Panel lets you choose which.

Alias
An Alias is a shortcut to a file,
application or folder stored
somewhere else on your hard
disk. Aliases are especially 
useful for placing on the Apple
menu, so that you’ve got quick
access to your favourite items
without having to take them 
out of your nicely organised 
filing system (more on this in a
few pages).

Theme
Like Windows 95 and Windows
98 on PCs, the iMac can now be
set up with desktop Themes,
which are matching desktop
backgrounds, fonts, sounds and
colours. To apply Themes all you
have to do is click on Appearance
in Control Panels.

Text insertion point
A potential source of confusion
when you’re just starting out. You
use the mouse to click at the
point in your document where
you want to start typing. The
insertion point stays where it is,
even though the mouse pointer
carries on moving around the
screen. Any text you type will
appear at the insertion point,
rather than the current mouse
pointer position.

Custom items
You won’t find these items on
your iMac’s Apple menu
because we put them on this
ourselves. That’s the beauty of
the Apple menu: you can put
what you like on it. All you have
to do is place the item (or an
alias) in the Apple Menu Items
folder in the System Folder

Recent Applications/Documents
The iMac keeps track of the last
10 software applications you
used and the last 10documents
you opened. They’re listed in
these submenus, and it’s often
easier to find them here than 
to track them down on your 
hard disk

Control Panels
Control Panels are used to
configure aspects of iMac
hardware, the operating
system and the applications
you’ve installed

Sub-menus
These arrows indicate
Apple menu options that
lead to sub-menus

Calculator, Key Caps 
and other accessories
You’ll find various handy
utilities on the Apple
menu. Key Caps, in case
you’re wondering, opens
a window where you can
find and use special
characters like
mathematical symbols
and foreign accents

The Apple menu
Apple menu
This is a single menu
offering access, via
sub-menus, to your
favourite applications,
documents, folders
and tools. Open it by
clicking on this apple
symbol to the far left
of the menu bar. It’s
visible at all times

Appearance. One of the great

things about the iMac is the

amount of control you have

over the interface. This is one of

the iMac’s most complicated

Control Panels, but there’s lots

to play with here.

Control Strip. You may have

noticed the Control Strip along

the bottom of your screen. This

strip offers fast access to many

of the controls offered by the

Control Panels. It has its own

Control Panel for setting its

various display options.

Date and Time. You use this

Control Panel to set the current

time and date. iMacs are

shipped around the world, so

you’ll also need to tell it which

country you live in so that it

works in the right time zone.

Set it up to allow for British

Summer Time automatically.

General Control. Use this

Control Panel to set the rate at

which the insertion point

blinks (hey, it matters to some

people)! You can also choose

the folders that applications

default to when opening or

saving documents.

Mouse. Is your mouse too fast?

Having trouble getting used to

this double-clicking lark?

Novice users will find this

Control Panel useful because it

lets them slow the mouse down

until they get used to it.

Sound. You can use this to

change the Alert sound your

iMac makes when it wants your

attention. You can use it, too, to

check your speaker balance,

and switch audio input between

the CD-ROM drive (which you

can use for audio CDs) and the

in-built microphone.

Get your insertion point to blink
faster. Anything’s possible!

There are a few elements of the Control
Panel which are essential to know

Control Panels
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he System folder

contains the whole of

your iMac’s OS

software and various

other important applications,

utilities and files needed to

keep it running smoothly.

It’s stored on your iMac’s

internal hard disk. Double click

on the hard disk icon on your

Desktop and scroll down the list

of files until you come to it.

Take a look at our

annotated diagram to find some

of the more significant files and

folders it contains. The fact of

the matter is, though, that if

you don’t understand what the

System folder does, you should

leave it alone. If applications

need to install files in the

System folder, they’ll do it

automatically, and the

operating system itself fetches

and manages the data in the

System folder without any

intervention on your part.

Why does the System folder

contain so many files? Because

modern computer operating

systems are ‘modular’. It’s more

efficient to build them out of

many interdependent modules

rather than one big file. Think

of your iMac’s system software

as a jigsaw puzzle.

The only time you need to

fiddle with the contents of the

System folder is if your iMac or

its software is playing up. You

can resolve Extension Conflicts

by manually disabling System

Extensions but you need a bit

of experience for this.

You may be called on to

install fonts, Control Panels or

Extensions manually. It’s easy!

You just drag them on to the

System folder icon and they’re

automatically inserted into the

appropriate folder inside it.

The System folder should not be tampered
with willy nilly, Here’s why…

Getting started

Extensions conflict
The more software you have
installed, the greater the
possibility (it’s still pretty remote,
though) of an extensions conflict,
where two System software
components from different
software publishers conflict with
each other and cause problems
either with the operating system
or your software.

Font
A character style. You can get
serif fonts where the characters
have little tails, sans serif fonts
without the tails, heavy fonts
with thick characters, and
condensed fonts and so on.

Install
Software applications these days
are a whole collection of files,
some of which may have to be
stored in specific locations on
your hard disk. Applications
come with installers which place
these files in the correct places
(some may need to go in the
System Folder) automatically.

Jargon
buster

T

08 youriMac

✁
C

ut o
ut and

 keep

✁

System folder contents

Double click on a font and double
click on one of the font files. You’ll
see a preview of how it looks

The Scrapbook is on the Apple
menu. Store pics, sounds and text

The System folder

Preferences
Just about all applications store preferences, listing

details about your hardware setup, your username, any
custom settings you’ve chosen. This is where they live

These are by no means all the files and folders you’ll find in your iMac’s System folder, but they’re some of the most important.

Finder
This is the program that works
alongside the System Software 

to provide your iMac’s user interface.
It starts automatically so no need 

to double click it

Fonts
This is where all your iMac’s fonts

are stored. You can double click this
folder to open it and take a look, if
you like. Double click a font file to
see what the characters look like

System
Don’t mess with this file! It’s central
to the iMac’s operating system and

should be left well alone.

Startup Items
Any alias, application or file you put
in here will start up automatically
whenever you start your iMac

Clipboard
When you copy an object in an
application, it’s stored in this
Clipboard file. You’ll never need to
open it directly, but at least now you
know where it is!

Apple Menu Items
All the options on the Apple menu
come from this folder. Open it and
you’ll see the folders, files and
aliases that you see on the menu.
You can add items of your own too

Extensions
The System file may be the heart of the OS, but your iMac

needs many support files too which add functionality.
This folder contains these System Extensions

Control Panels
Control Panels are like System Extensions in that they
add tools and features to the basic OS. These are the
Control Panels you access via the Apple menu

Scrapbook
You’ll find the Scrapbook on the Apple menu. It’s like
the Clipboard, but you can use it to store text, pictures
and sounds in a kind of scrolling gallery



verything on your

iMac is represented by

an icon, but how do

you tell one type of

file from another, and how do

you organise these icons?

For a quick guide to

recognising icon types and

what they mean, take a look at

our annotated illustration. But

whatever icons represent, you

can move and organise them in

much the same way.

To move an icon to another

place on your desktop, for

example, you click on the icon

and, still holding down the

mouse button, move the mouse

and release the button when

the icon’s in the right place. To

rename an icon, click on it once

and wait for a few moments. The

name will be highlighted ready

for you to type over it.

You can move icons from

one folder to another simply by

opening both folder windows

and dragging the icon from one

to the other. We’ll go into more

detail about organising your

folders in the next section.

Aliases are special types of

icons. They’re not real items at

all, merely shortcuts to folders,

files or applications. To create

one, click on an icon and

choose Make Alias from the File

menu. Put the alias wherever

you like, and double clicking it

has the same effect as double

clicking the original item.

When we say icons, we don’t mean world
leaders. Read on and find out…

E

Icons

own in the bottom

righthand corner of

your Desktop

(unless you’ve

moved it) is the Trash icon. This

looks and behaves just like a

normal dustbin. When you

don’t want things anymore, you

just drag them onto this icon

and they disappear into the

Trash. Easy eh?

You can see when

there’s stuff in the Trash:

the icon changes. The lid

slips down over the side and all

your rubbish is bulging out.

The thing is that the bin men

don’t come round to empty the

Trash, and you have to do it

yourself via the Special menu.

Don’t be in a rush to empty

the Trash, though, because you

may need to recover stuff you’ve

thrown away by accident. To

find out what’s in the Trash, just

double click its icon. You can

then drag stuff back out if you

need to. Many iMac users only

empty the Trash when they run

out of hard disk space.

Store your waste in the Trash and only
delete it when you’re sure it’s rubbish

D
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Button
Computer software designers
have standardised on on-screen
gadgets and how they work. Icons
need to be double clicked to
‘activate’ them, while buttons
only need to be clicked once.
Easy to get used to.

Document
A word usually used to describe
word processor files, digital
images, spreadsheets and other
things you create and save.

File
File is a broad term for just about
any single item (except a folder,
which is just a container) on your
hard disk. You can have document

files, application
files, preference
files and so on.

Highlighted
When you click on
an icon, it changes
colour (it’s
highlighted’ to
show that it’s ready
for moving,
renaming or other
operations. It’s like
highlighting text in
a word processor
document to
change it.

Thumbnail
Sometimes icons
aren’t enough to

help you identify files. That’s why
some image-editing programs
generate icons that look like
miniature renditions of the
picture itself. These are called
Thumbnail images (well, they’re
sort of thumbnail-sized) and are
widely used for previewing files
before you open them.

Alias
An Alias is a shortcut to a file,
application or folder stored
somewhere else on your hard
disk. Aliases are especially 
useful for placing on the Apple
menu, so that you’ve got quick
access to your favourite items
without having to take them 
out of your nicely organised 
filing system. Click on the icon
itslef once and go to Make ALias
under the File menu. Drag the
alias to wherever yo want it to be.

You can
recognise an
alias by the
little shortcut
arrow to the
bottom left of

the icon and the fact the icon
name is in italics

When the Trash is empty (far right) and full
(to the left) and Trash contents

Choose your view

Trash

Which OS do you have?

Folder
Double click on a folder icon and

it opens a folder window where

you can see the contents.

Document/file
Double click on a document or

file and your iMac will find the

right application to open your

document ready for viewing or

editing. Most applications

generate documents which have

readily-identifiable icons, like the

big blue ‘W’ which is used for

Microsoft Word.

Application
Double clicking an application’s

icon starts that application.

Open folder/file
When an icon is greyed-out, it

means the item is already open.

View as Icons
This is the view most
people use, displaying 
the icons we’ve been
describing

List view
This is the view favoured
by most iMac experts. The
icons are smaller but you
see other information too

Button view
Useful for those who aren’t
used to iMacs or mice. You
only have to click on them
once to activate them

When you double click on a folder icon to view its contents in a window, you can display

those contents in one of three ways via the View menu.
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olders are central to the

way you and your iMac

store things. We’ve seen

how the iMac uses the

System Folder to store and sort

components of the OS, but the

rest of the hard disk is free for

you to organise as you wish.

Folders are containers.

When they’re closed, you just

see the folder icon. When you

double click on them to open

them, you see the folder

contents displayed in a window.

These contents can include

various files and folders. In fact,

there’s no limit on how many

folders-

within-folders

you can

create. But

where do you

start? Double

click on your

iMac’s hard

disk icon on

the Desktop

and you’ll find there are many

folders and files there already.

Any more programs you install

will add folders of their own.

Why not create a folder

called My Stuff on your hard

disk, and store stuff there? By

the way, you can’t fill folders up.

Just because the icons are all

the same size, it doesn’t mean

the contents are too. Folders

expand to accommodate

everything, until there’s no

space left on your hard disk.

Where am I?

The only trouble with complex

filing systems

and space

available on

your iMac’s

hard disk is

that it can be

easy to get

lost if you’re

not highly

organised.

For example, you may have a

folder window open, but no

idea at all where that folder is

in your filing system. There is

an easy way to find out, though.

You see the name of the folder

in the middle of the title bar at

the top of the folder window?

Hold down the Command

(Apple) key and click on it.

Down pops a menu listing the

‘parent’ folders the current

folder is stored in.

If you do get lost in your

own filing system, the quickest

way to re-orientate yourself is

often just to go straight back to

the Desktop and start again.

And here’s another tip for

you: if your Desktop is just a

mass of open windows, hold

down the Option key and click

on the Close box of any of them.

This will close the lot, leaving

you with a nice, clear Desktop.

Folders are like those in filing cabinets,
except these never get full to bursting

Getting started

Active window
Only one window can be active,
i.e. on top of the rest and ready
to use, at any one time. You click
on any part of a window to make
it active so that you can, for
example, create a new folder in it,
or move some of the contents.

Contextual menu
A fancy term for the shortcut
menu which appears when you
hold down the Control key and
click inside a folder window. You
can create new folders using this
menu, amongst other things.

Directory
This is another word for folder.
You’re most likely to hear PC
owners talking about directories,
which is a leftover from the days
when computers accepted text
input only and dinosaurs walked
the earth.

Hierarchical folders
Normally, you double click on
folders to view their contents in a
new window. If you choose List
view, though, you can expand
their contents in a tree-like
structure by clicking the little
right-facing arrows before the
folder names.

Volume
Another word for disk. The iMac’s
hard disk is a ‘volume’, as is any
CD-ROM you insert. Effectively,
though, they work like folders,
with icons you double click to
examine the contents.

System folder
As we said a couple of pages
previously, the System folder is
an important part of your iMac.
However, make sure you know
what you’re doing before you
start meddling with its contents
as you may inadvertently 
delete some files or folders 
which are essential to your 
iMac’s functionality. 

Jargon
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Get yourself organised!

Here’s a quick guide to

setting up your own filing system.

It’s easy!

First, you need to create a new

folder on your hard disk. Double

click the hard disk icon to open its

window, then choose New Folder

from the File menu.

Congratulations! Now you know all

there is to know about creating

folders. So simple!

By default, new folders are

called ‘untitled folder’. You’ll want

to change that, won’t you? The

name will already be highlighted,

and you can simply start typing a

name of your own choice. If the

name’s not

highlighted, click on

the icon just once

and wait a couple of

seconds. If you

double clck by

mistake, it will open

and you’ll have to

wait, close it down

and then start again.

Now it would be

nice if our new folder

was on the Desktop

so that we don’t have

to double click on

the hard disk icon to get to it. Easy.

We just drag it from the hard disk

window on to the Desktop. Now

you know how to move folders.

To create new folders within

your folder, double click its icon to

open it and then use the New

Folder command on the File menu

again. To add items to your folders,

open the folder they’re currently in

and just drag them across.
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Folders

Creating folders is an easy way of filing and it
prevents your iMac from getting messy

Call your folders whatever you
like, but make it logical. Click
and drag to move around

When saving files, you get to
‘navigate’ the filing system as
you choose a place to save them

Find out where the current folder is by
Command, clicking on its name 



he iMac’s mouse is a

busy creature. Nearly

every activity involves

clicking, dragging and

pointing, and you could be

forgiven for thinking that the

mouse is indispensible.

For many operations it is. At

other times, though, it’s not

necessarily the quickest way to

do things. Experienced iMac

users soon realise it’s quicker to

tap a couple of keys than to

move the mouse around.

Try opening a folder

window and then clicking on

the File menu. See the New

Folder option? Ah yes, and do

you see the Command, N

symbols alongside it? That

means you can activate that

option by holding down the

Command key while you hit N

on the keyboard. Hey presto! 

A new folder.

It’s standard practice for

software designers to display

alternative keyboard shortcuts

so that, as you gain experience

with the software, you can start

to remember the shortcuts and

save yourself some time.

Certain keyboard shortcuts

are standardised across all

kinds of software. Take a look at

our Favourite shortcuts table.

You’ll see that many shortcuts

rely on the Command key. (It’s

often written as Command

because the symbol on the key

itself isn’t always easy to

reproduce in print.) 

The Command key is a so-

called Modifier key. You use it

in conjunction with other keys

to modify what they do. There

are other modifier keys on the

iMac keyboard. See table below

to see what they’re called.

You’ll also spot an Esc key

in the top lefthand corner of

the keyboard. The Esc key is

often used to interrupt a

running process, and one of its

more notable uses is in the

shortcut for quitting an

application that has stalled, or

‘hung’. You can force quit such

an application by hitting Alt,

Option, Esc at the same time.

At the same time? Really?

No, that’s quite difficult. In fact,

when you use a keyboard

shortcut, you hold down the

first key in the series, then the

second and so on, releasing

them all at the same time when

the action’s been carried out.

And what about the row of

function or F keys running

along the top of the keyboard?

What are those for? Well if you

open the Keyboard Control

Panel, you’ll find out. Hit the

Function Keys button and you’ll

find out you can assign any

item on your hard disk to any

key. You could assign your

‘Work in progress’ folder to the

F1 key. Anytime you need to

open the folder, hit that key.

Lastly, the new Apple Pro

keyboard, shipped with new

iMacs, has extra keys. Just above

the numeric keypad, you’ll find

easy-access volume controls,

and a CD-ROM eject key. There

are now 15 Function keys

instead of the 12 we described,

and they’re larger too.

Why reach for your mouse when you can save a
bit of energy with shortcuts?

T
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Finder
The Finder is the application that
lets you manage files and folders,
launch applications and so on. 
It’s the bit of the operating
system you ‘see’, and it’s always
running in the background even
when you’re hard at work in 
other applications.

Force quit
If a program has stalled, or
‘crashed’, it’s stopped working,
which means you won’t be able to
quit it either using the menus or
the Command, Q shortcut. The
Alt, Command, Esc keyboard
shortcut bypasses this to force
the application to quit.

Function keys
The row of keys running along the
back of your iMac keyboard. They
can be programmed with your
own shortcuts.

Modifier key
A key which ‘modifies’ the
behaviour of other keys to give
you additional options and
commands. The Shift, Control,
Alt and Command keys are all
Modifier keys.

Numeric keypad
The ‘mini-keyboard’ positioned
just to the right of the iMac’s
main keyboard. It has the numeric
keys and mathematical operators
like +, -, = and so on. These keys
are on the main keyboard too, but
if you’re using a spreadsheet, it’s
convenient to have them laid out
like this, as you would with a
pocket calculator, for example.

You can assign folders, files and
applications to your iMac’s F keys

Keyboard
shortcuts

Our favourite shortcuts

Command, N Creates a new file or, in the case of Finder,

creates a folder in the current window

Command, O In an application, this shows a dialog where

you can choose the file you want to open

Command, S Saves the current file if you’re working in

an application

Command, A Selects everything in the window, whether

it be a folder or an application

Command, Q Quits the current application. If you’re

working in the Finder, this has no effect.

Alt, Command,

Esc

Forces a stalled application to quit

Option, drag Creates a copy of an object as you drag it,

instead of simply moving it

Option,

Command, drag

Creates an alias of a folder or file etc in

the Finder

Shift,

Command, 3

Captures a ‘screenshot’ of the entire

display and saves it to the hard disk

Shift, Click If you hold down the Shift key you can

select objects lots of objects at once

Shortcut Function Shortcut Function
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our iMac is pretty self-

contained. It comes

pre-installed with a

whole heap of

software, and there’s plenty of

space on the hard disk for

saving files. But you still need

your CD-ROM drive for playing

audio CDs and for installing

new software.

Inserting a CD

You insert a CD in one of two

ways, depending on how old

your iMac is. With the earlier

models, you press the button on

the front of the CD tray. After a

few moments, the tray slides out

and you can load a CD.

Double click on it to take a

look at the contents of your CD

or it may open automatically. If

it’s an audio CD, it’ll start

playing of its own accord.

If you’ve got a newer iMac,

there’s no CD tray at all.

Instead, you get a slot-loading

unit just like those fitted to in-

car hi-fi systems. You slide the

edge of the CD into the slot,

and the iMac grabs it and sucks

it in the rest of the way. 

Ejecting

Ah, but how do you get your CD

out again? To eject a CD, you

have to drag its icon on to the

Trash icon. The iMac will then

whir briefly and eject your CD.

This applies to both older

iMacs and the slot-loaders.

The hard disk in your iMac

is actually a hard disk ‘drive’,

you insert CD-ROMs into your

iMac’s CD-ROM drive, and you

can buy various plug-in USB

drives too, including floppy disk

drives, Zip drives, SuperDisk

drives and more.

They all work in much the

same way, where the iMac has to

‘mount’ a disk before its icon

appears on the desktop. Also,

you get it to ‘unmount’ the disk

by dragging it to the Trash.

Shut Down or Sleep?

That’s how you eject disks when

you’ve finished with them, but

what’s the proper way to switch

off the iMac itself? 

Don’t yank out the power

lead because, while you may get

away with this in the short term,

it does computers no good at

all. They have to do a ‘shut

down’ procedure to ensure your

data is saved and the hardware’s

not subjected to abuse.

There’s more than one way

of shutting down your iMac.

(Though the methods may vary

according to which iMac you

have and which

version of the

operating system

you’re using.)

The usual way is

to close files and

applications so

you’re back at the Desktop,

then choose Shut Down from

the Special menu. Or press the

Power button on the monitor.

This closes all your files and

applications and shuts down in

one go (you’ll be warned if any

of your files haven’t been saved

and given the chance to do it).

Or you can press the Power

key on the keyboard. This is a

little more useful because it

gives you a whole series of

options. You can Shut Down,

Restart, Sleep or Cancel.

Saving your energy

The iMac’s Sleep mode is a

smart idea in our energy-

conscious world, but you don’t

have to send it to sleep

manually. If you open up the

Energy Saver Control Panel

you’ll find you can get your

iMac to send itself to sleep after

a fixed period of inactivity. 

And, in case you use your

iMac to receive faxes, you can

schedule it to start up and shut

down at times which suit you.

Getting started

Sleep
‘Sleep’ only half powers down
your iMac. It goes into a standby
mode where the screen goes
black and it consumes a lot less
power. You can re-activate it with
a simple mouse click, and it
comes back to life far faster than
if you’d shut it down and then
restarted it. You can leave your
documents and applications
open, too.

Restart
Restart is a useful option when
the system software or one of
your applications has become a
little unstable. It happens from
time to time, and you’ll usually be
told when it’s a good idea to quit
your work and restart.

SuperDisk
A type of disk drive made by
Imation and others that accepts
both ordinary floppy disks and
special SuperDisks. The latter are
the same size as a floppy disk,
but store a massive 120MB of
data instead of a floppy’s meagre
1.44MB. You can get SuperDisk
drives that plug straight into one
of your iMac’s USB ports.

Plug-in
A special file that you place in an
application’s folder that extends
a piece of software’s function.
Programs such as Photoshop and
iMovie use plug-ins a lot.

Zip
A very popular disk drive format.
Zip drives are relatively
inexpensive (under £100) and,
like the SuperDisk drive, plug
straight into an iMac’s USB port.
The cartridges hold 100MB of
data, and cost between £7 and
£8 each. They’re more widely
used than SuperDisks and, in
terms of cost-per-megabyte, 
offer similar value.
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Don’t forget that your iMac can also play
music CDs, show films and much much more

Inserting
discs and

shutting down

When you insert an audio CD, it
starts playing automatically. Enter
track information and playlists
using the Apple Audio CD Player

With Energy Saver Control Panel,
your iMac will sleep when not
being used

If you shut down your iMac using the Power key, you
can restart, or choose Sleep mode instead
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Pop-up
You don’t just find menus on the
menu bar. You can also find them
within dialogs and palettes and
on the Control Strip. These are
called pop-up menus, although
they can pop up and down.

Handle
Many objects you’ll see on the
screen have handles. You drag on
handles to move or resize objects.
You drag on a window’s Resize
handle to make it bigger, for
example, and the Control Strip’s
handle to change the length.

MP3
A special compressed file format
for music. It squeezes tracks into
around a 10th of the space
needed by an audio CD track,
which makes it very popular for
Internet music downloads.

Sleep mode
If your iMac’s to be left unused
for any length of time, you can
configure it to ‘go to sleep’
automatically, or send it to sleep
manually via the Control Strip.
This darkens the display and
spins down the hard disk.

Internet account
Before you can surf the Net you
need to set up an account with an
Internet Service Provider. You’ll
also need to configure your iMac
with the account details.

e mentioned your

iMac’s Control

Strip in the Apple

menu and

Control Panels section earlier.

It’s the little handle you see in

the bottom lefthand corner of

your screen.

Click on this handle and

the Control Strip opens out.

Click on the handle again (now

at the far righthand end of the

Control Strip) and it retracts

back into the corner again.

If you don’t see the Control

Strip, that’s because it’s been

disabled in the Control Strip

control panel. You can open

this control panel via the Apple

menu, and you’ll spot that it

also lets you choose a

font and size for the

pop-up Control Strip

menus, and even a

keyboard shortcut for

showing and hiding

the Control Strip.

What’s it for?

The Control Strip is

provided so that you

get much faster 

access to some of the

most commonly-

needed iMac options.

Here, you’ll find

buttons which do the

same thing as Control 

Panels, but they’re very much

easier to get at.

Take a look at our iMac’s

Control Strip in our annotated

diagram. We say ‘our’ iMac,

because your machine’s

Control Strip may look

different, depending on the

settings you’ve chosen and the

software you have installed

(some programs install buttons

on the Control Strip, like our

SoundJam MP3 player, shown

in the picture). A Control Strip

takes up none of your Desktop

space unless you’re using it at

the time. Indispensable!

Keep our frequently used applications in one neat place so that’s
they’re easily accessible but don’t clog up the desktop

W

Control Strip

A quick tour of your Control Strip
These are by no means all of the files and folders you’ll find in your iMac’s System Folder, but they’re some of the most important.

Close box
Click this box to

shrink your Control
Panel back into the
left-hand corner of

your display

Drag handle
This handle is
always visible.
Click it once to
switch between
the extended/
collapsed view

Audio CD controls
When you insert an audio CD, your iMac

will start to play it automatically. You can
start the Audio CD Player, or use the Stop,

Start and Skip on this pop-up menu

Set display resolution
The default iMac screen size, or

‘resolution’ is 800x600 pixels. You
can choose 640x480 pixels, or

1,024x768 pixels 

Volume control
Don’t waste your time looking for a
volume knob on your iMac! Open this
pop-up menu instead and move the
slider to change the volume level

Internet connection options
When you set up an Internet account, it
appears on this list (we have several).
You may need to disconnect manually
when you’ve finished surfing 

Energy Saver/sleep options
Use this pop-up menu to configure

your energy conservation options or
even send your iMac to ‘sleep’

Set display colours
You’ll want your iMac’s

display set to the default
‘millions’ of colours, but you
can reduce this number too

Configure your Control Strip via the Control
Panel. Assign a keyboard shortcut it and
change the fonts used for pop-up menus

Buttons on the Control Strip
display a pop-up menu when you
click on them. Some apps add
their own Control Strip buttons

Pop-up menus are brilliant for
quick access to certain folders.
Go to View on the Desktop menus
and click on As Pop-up Menu 
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e mentioned how

to customise

your iMac earlier.

Here’s more on

how you can change your iMac

to suit the way you use it.

Why not create a Desktop

background? You can do this

with a scanned photo, a digital

camera image or an image

downloaded from the Net.

Open the Appearance Control

Panel via the Apple menu, click

Desktop and then Place Picture. 

Alternatively, you can use

an image-editing program like

PhotoDeluxe to resize the

image so that it matches the

display size (800x600 pixels by

default). This means that you

don’t have to fiddle with the

positioning options.

Change your fonts 

While you have the Appearance

Control Panel open, click the

Fonts tab. You’ll find you can

change the menu bar, menu,

dialog and other fonts used by

your iMac, and you can change

the size they’re displayed at too.

Change your colours

Fiddle with colour schemes by

switching to the Appearance

tab. The Appearance menu lets

you apply overall ‘looks’ to your

menus, icons, controls and so

on, and you get the Apple

Platinum appearance provided

as standard. It’s also possible to

download ‘themes’ from the

Internet, though. These are

created by programmers and

designers around the world.

Using themes

If you click on the Themes tab

itself, you’ll see previews of all

your installed themes, and you

can apply them from here too.

Indeed, you can create your

own custom themes by

manually changing the options

in the Appearance Control

Panel’s other tabs and then

clicking the Save Theme button

in this one.

Change your sounds 

In the Sound tab, you’ll find

that you can apply the Apple

Platinum sound effects to

events like menus opening,

windows being moved, clicking

and dragging options and more.

If this cacophany of sound

gets a bit too much for you, you

can switch off the effects you

don’t want by clicking the

checkboxes in this window.

Smart scrolling

The last tab, called Options,

controls (amongst other things)

the way the scrollbars and

arrows are displayed in

windows. Normally, the scroll

arrows are placed at opposite

ends of the scrollbars.

This is logical, but it means

you’ve got to keep moving your

mouse to scroll one way, then

the other. The alternative is to

opt for Smart Scrolling, where

arrows are placed next to each

other at the bottom of vertical

scrollbars and at the righthand

end of horizontal ones.

It takes a bit of getting used

to, and it’s not as logical as the

usual arrangement, but Smart

Scrolling does actually save you

time and effort in the long run

so give it a go.

Personalise your iMac so that it’s your and only yours
with holiday snaps as backgrounds and groovy fonts

Getting started

Alert
A special window that pops up to
explain implications of a choice
you’re about to make, the
dangers of carrying out a
command or just to provide
information about what’s
happening. When you’ve read the
message you simply close the
window or click an OK button.

Pixels
The individual blocks of colour
that collectively make up the
images you see on your screen.
By default, your iMac’s display is
set to a resolution of 800 pixels
across by 600 down.

Tab
The iMac uses special windows
called dialogs when it needs to
get further information from you.
These dialogs are often split up
into individual screens. You click
on a button rather like a folder
tab to switch between them.

Theme
Your iMac’s desktop, fonts,
colours and window styles can be
packaged up and distributed as a
single ‘theme’.

Jargon
buster

W

14 youriMac

✁
C

ut o
ut and

 keep

✁

Customise your
Desktop

The Appearance Control Panel

The Appearance Control Panel (in the Apple menu) lets you do all the finishing touches, like font

changes, colours, Desktop patterns and the sound setup.

Themes tab displays your
installed desktop themes, letting
you switch and save your own

1 The Appearance tab changes
colours and the look of windows,
icons, menus and pointers

2 Use Fonts tab to change fonts
and text sizes in menus, windows,
alerts, icons and folder contents

3

Use a pre-installed Desktop
pattern or one of your own digital
images via the Desktop tab

4 Click Sound tab to have
sound effects applied to menu
selecting and other operations

5 Options controls how scroll
bars are displayed and shrinking
rules of title bars

6
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Radio button
Radio buttons are arranged in
sets and are mutually exclusive, in
that only one of them can be
highlighted. Click on another, and
the first one is de-selected. Radio
buttons are used where you’ve
got to choose only one of two or
more options.

Hierarchical list
You can open up folders in List
view windows to display contents
in a ‘hierarchical’ list by clicking
on the arrows next to them. It’s
hierarchical in that folder
contents ‘belong’ to the next
folder up in the hierarchy. 

Navigation
A word for exploring, or finding
your way around the contents of
your hard disk. For example, you’ll
often find computer magazines
explaining that you’ll need to
navigate to certain folders.

Submenu
Many menu options have right-
facing arrows next to them, which
indicates that when you move the
mouse pointer over them another,
smaller menu (‘submenu’ will
open up. These can also be called
‘hierarchical’ menus.

e looked briefly at

how folders

worked earlier,

demonstrating

how you set up and organise

your own filing systems. Here’s

how to customise the way your

folders look and behave so your

information isn’t organised, it’s

easy to browse and locate too.

List view basics

One of the first things expert

iMac owners do is switch their

folder views from the standard

Icon view to List view. You’ll find

these options on the View

menu. Items in your folders are

shown as single-line entries

rather than icons, and these

entries include the name of the

item, the date it was modified,

its size and what type of file it is.

Information is arranged in

columns, and you can ‘sort’

folder contents alphabetically

by their name, according to the

date they were last changed,

their size and their type. You do

this simply by clicking on the

column heading you want to

sort the contents by.

Changing your columns

Sometimes you may find

the information won’t fit

within the column width.

The names of some of

the files and folders, for

example, may be too

long. That’s easily fixed.

You drag the dividing

line between the column

headings to the left or

right (the cursor

changes appearance

when the mouse pointer

is in the right place).

You can even choose which

information is displayed in

these columns. To do this,

choose View Options from the

View menu and choose which

columns to display by checking

their boxes in the list.

Changing icon sizes

What’s especially neat, though,

is that if you really want the

best of both worlds – chunky,

colourful icons AND detailed

information – you can have it.

Still in the View Options dialog,

simply pick one of the three

available icons sizes by clicking

the radio button which is

directly underneath.

Hierarchical lists

The cleverest thing of all about

the iMac’s List view, though,

becomes apparent when you

click one of the right-facing

arrows next to a folder. The

folder opens out to display a

‘sub-list’ of all its contents. Any

folders within this sub-list will

also have arrows which can be

clicked on to display the

contents of that folder too.

By double clicking the Hard

Disk icon on your desktop, you

can display the contents of your

hard disk as a hierarchical list

within one window.

List views are just one way

of exploring the contents of

your iMac. See the boxes on 

this page for three more

display/navigation tips.

You can view folders and their contents in
many ways. Whatever’s easiest on the eye

W

Arranging icons

If you’ve been dragging your

folder icons around in Icon view

and you’ve left them in a mess,

use the Clean Up option on the

View menu to line them all up

again. And you can use the

Arrange submenu options to

organise them according to

name, size and other criteria.

Customise your
folders

Choose your view
One of the iMac’s lesser-known features is also one of its most useful.

You can store an item anywhere you like on your hard disk just by

dragging it on to the hard disk icon. Just wait a moment, and the icon

opens into a list of the hard disk contents. Move your item over further

sub-folders to ‘drill down’ to the folder you want.

When moving things around, click and drag the item and hold it over
the item. If you hold it long enough, the destination will open up

Choose which columns to display
in List view via View Options 
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e’ve spent the

past 15 pages

giving you a

guided tour of

the iMac, but it may not be

enough. Here’s a lookat the

help available.

Using the help system

Your iMac’s Help Center

(American spelling) provides

help with your hardware, the

iMac OS and many of the

applications you have installed.

If you want to know more

about your iMac, click the

About Your iMac option. If you

need to know more about

Control Panels, folders and

other on-screen controls, 

click on Mac Help.

Once you’ve chosen what

you need help with, you’ll see a

list of topics down the lefthand

side of the screen. Click any

one of these to see a list of

further sub-topics. By clicking

on the topics you can zero in on

just the information you need.

Alternatively, type a word or

phrase into the Search box at

the top of the window and hit

the Return key. You’ll then be

given a list of matching topics

to examine.

Lost your way?

Sometimes the easiest way to

get out of a tricky situation is to

get back to the Desktop and

start again! One common cause

of disorientation stems from

the fact that the iMac can run

several programs at the same

time and you may lose track of

which one you’re working in.

This is especially likely where

you’ve closed a document

window but left the application

running. You can ‘see’ another

application in the background

but the menus don’t match.

You can sort all this out via

the Applications menu to the

far right of the menu bar. This

lists all the programs currently

running, and lets you switch

between them. See our

walkthrough for a bit of help.

Lost your files?

There’s a third way of getting

confused, and it’s when you

know you’ve saved a file but

you’ve no idea where it is.

It’s easily done, especially if

you don’t look carefully at the

Save dialog when you first save

the file. Sherlock is the answer.

It’s a powerful search tool built

into the iMac OS, and you

activate it by choosing Find

from the File menu.

You type the name of your

file (or even just part of the

name) into the box, hit the

Return key and Sherlock will

find all instances of that name

on your hard disk. It lists their

locations, and you can even

double click found items to

open them or drag them from

Sherlock on to your Desktop or

into another folder.

If the last 15 pages weren’t enough to put
you at ease, here’s some extra tuition

Getting started

Desktop
This is what you see when you
first start up your iMac, and it’s
like your main working area where
you see your hard disk icon, the
Trash and other items. Most
people use it as the starting
point for their work.

Finder
This is the part of the iMac
operating system software that
you ‘see’, and it’s a program that
runs continuously (you see it on
the Applications menu) and
provides the tools for displaying
and organising the files and
folders on your hard disk.

Save dialog
When you’re working on a
document using an application
like AppleWorks, sooner or later
you’ll need to save your
document as a file on your hard
disks. The Save dialog displayed
when you do this doesn’t just ask
you to choose a name for the file,
but a location too, based on the
folders set up on your hard disk.

Tear-off
The Applications menu is 
actually a ‘tear-off ’ palette. This
means that if you click it to open
it but keep the mouse button
pressed and drag downwards, 
the menu is detached from the
menu bar and remains open,
floating on the screen all the
time. You may find it more
convenient to work this way.

Jargon
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Help!

The Applications menu

Use the Applications menu to swap between programs you’re working with

When running several programs, the
Applications menu can help you find what’s
going on. Use it to get back to the Finder

1 In the Finder, choose Hide Others from the
Applications menu to hide other programs. Get
back to them by choosing them from the menu

2 You can finish clearing the screen by
Option, clicking on the Close box of any open
folder windows. This closes all open windows

3

Your iMac’s online Help system
can explain both how your
hardware works and how to use
menus, dialogs and so on

Sherlock can get you out of many a
fix! Use the Command, F shortcut
to activate it from the Desktop

Right , so now you’re up and
running, but don’t miss the
next instalment: getting 
connected to the Internet


